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END USER LICENSE AGREEMENT 

BY ACCEPTING, YOU (ORIGINAL PURCHASER) INDICATE YOUR ACCEPTANCE OF THESE 
TERMS. IF YOU DO NOT WISH TO ACCEPT THE PRODUCT UNDER THESE TERMS YOU MAY 
CHOOSE NOT TO ACCEPT BY SELECTING "I decline..." AND NOT INSTALLING THE 
SOFTWARE. 

The name Acronis, the software, the product name Acronis True Image, and the Acronis 
logo are registered trademarks of Acronis Inc. BVI. Acronis True Image (the Software) is 
copyright 2000-2006 by Acronis. All rights are reserved. 

The ORIGINAL PURCHASER is granted a LICENSE to use the software only, subject to the 
following restrictions and limitations. 

1. The license is to the original purchaser only, and is not transferable without prior written 
Permission from Acronis. 

2. The Original Purchaser may use the Software on a single computer owned or leased by 
the Original Purchaser. You may not use the Software on more than a single machine even if 
you own or lease all of them without the written consent of SonicWALL. 

3. The Original Purchaser may not engage in, nor permit third parties to engage in, any of 
the following: 

A. Providing or permitting use of or disclosing the Software to third parties. 

B. Providing use of the Software in a computer service business, network, timesharing or 
multiple user arrangement to users who are not individually licensed by Acronis. 

C. Making alterations or copies of any kind in the Software (except as specifically permitted 
above). 

D. Attempting to un-assemble, de-compile or reverse engineer the Software in any way. 

E. Granting sublicenses, leases, or other rights in the Software to others. 

F. Making copies, or verbal or media translations, of the user's guide. 

G. Making telecommunication data transmission of the software. 

SonicWALL and/or Acronis has the right to terminate this license if there is a violation of its 
terms or default by the Original Purchaser. Upon termination for any reason, all copies of the 
Software must be immediately returned to SonicWALL, and the Original Purchaser shall be 
liable to Acronis for any and all damages suffered as a result of the violation or default. 

ENTIRE RISK 

THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE IS WITH 
YOU THE PURCHASER. NEITHER SONICWALL NOR ACRONIS WARRANTS THAT THE 
SOFTWARE OR ITS FUNCTIONS WILL MEET YOUR REQUIREMENTS OR THAT THE 
OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR FREE OR THAT ANY 
DEFECTS WILL BE CORRECTED. 

NO LIABILITY FOR CONSEQUENTIAL DAMAGES - IN NO EVENT SHALL SONICWALL, 
ACRONIS OR ITS VENDORS BE LIABLE FOR ANY DAMAGES WHATSOEVER (INCLUDING, 
WITHOUT LIMITATION, DAMAGES FOR THE LOSS OF BUSINESS PROFITS, BUSINESS 
INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER PECUNIARY LOSS) 
ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE, EVEN IF SONICWALL 
AND/OR ACRONIS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
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Chapter 1. Introduction 

1.1 What is SonicWALL Bare Metal Recovery and Local Archiving - 
Workstation? 

SonicWALL Bare Metal Recovery and Local Archiving - Workstation solves all backup 
problems, ensuring the safety of all information on your PC. 

Using it, you'll be able to create exact hard disk images, including all operating 
systems, applications and configuration files, software updates, personal settings 
and all of your data. 

If failures occur that block access to information or affect system operation, or if 
you accidentally delete necessary files, you'll be able to restore the system and lost 
data easily. 

You won't have to select files and folders for backup, as many backup applications 
require. Instead, you will store all your disk data. As a result, SonicWALL Bare Metal 
Recovery and Local Archiving - Workstation is simpler and faster than competitive 
applications. 

You can create images on local hard disks, CD-R/RW, DVD+R/RW, DVD-RW, or a 
variety of removable media, such as FireWire (IEEE-1394) and USB (1.0, 1.1 and 
2.0) devices. 

You can restore the partition or lost data from an image any time. You can also 
connect an image as a virtual drive, browse its contents and extract selected files to 
the hard disk. 

The unique technology developed by SonicWALL and implemented in SonicWALL 
Bare Metal Recovery and Local Archiving - Workstation allows you to create exact, 
sector-by-sector disk images and restore their content directly from Windows 
without the reboots typical for similar products. 

Wizards and a user-friendly, Windows XP-styled interface will make your work even 
more convenient. Just answer some simple questions and let SonicWALL Bare Metal 
Recovery and Local Archiving - Workstation take care of everything else! When a 
problem occurs, it will get you up and running in short order. 

1.2 What is a disk image? 
A disk (partition) image is a file that contains a copy of all information stored on a 
disk. The image stores the installed operating system, all programs, and all 
documents and settings. 
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By backing up your information regularly, you will protect yourself from data loss in 
case of system failure or PC malfunctions. 

By default, SonicWALL Bare Metal Recovery and Local Archiving - Workstation 
image files have a “.tib” extension and can contain images of several partitions or 
disks. 

Images of large partitions or several disks could be quite large. If so, they can be 
split into several files that together make an original image. A single image can also 
be split for burning to removable media. A single image that is split across multiple 
CDs is sometimes called a “spanned volume.” 

 

SonicWALL Bare Metal Recovery and Local Archiving - Workstation stores only those hard disk 
parts that contain data (for supported partition types). This reduces image size and speeds up 
image creation and restoration from. 

 

A partition image includes all files and folders independent of their attributes (including hidden 
and system files), boot record, FAT (file allocation table) and root. 

 

A disk image includes images of all disk partitions as well as the zero track with master boot 
record (MBR). 

1.3 Software usage terms and conditions 
The conditions for SonicWALL Bare Metal Recovery and Local Archiving - 
Workstation software usage are described in the «License Agreement» (page 3 of 
this manual). The unique registration number is a confirmation of your legal 
purchase and usage of SonicWALL Bare Metal Recovery and Local Archiving - 
Workstation on your system. 

Under current legislation, the «License Agreement» is considered a contract 
between you and SonicWALL Inc. The contract is a legal document and its violation 
may result in legal action. 

Illegal use and/or distribution of this software will be prosecuted.
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Chapter 2. Installation and operation 

2.1 System requirements 
SonicWALL Bare Metal Recovery and Local Archiving - Workstation requires the 
following hardware: 

• Pentium CPU and higher 

• 64 MB RAM 

• floppy disk drive or CD-RW drive for bootable media creating 

• mouse (recommended) 

2.2 SonicWALL Bare Metal Recovery and Local Archiving - 
Workstation installation 

To install SonicWALL Bare Metal Recovery and Local Archiving - Workstation: 

1. Insert the installation CD into your drive.  

2. Follow the instructions on the screen. 

After installation of SonicWALL Bare Metal Recovery and Local Archiving - 
Workstation is completed, you should restart your computer. 

2.3 Running SonicWALL Bare Metal Recovery and Local Archiving - 
Workstation  

In normal mode, you can run SonicWALL Bare Metal Recovery and Local Archiving - 
Workstation from Windows by selecting SonicWALL → Bare Metal Recovery 
and Local Archiving - Workstation → SonicWALL Bare Metal Recovery and Local 
Archiving - Workstation from Start → Programs. This will bring the program 
window onto the screen. 

If your disk data is totally corrupted and you can not boot, you should use the 
bootable media created during the installation procedure or later. It will 
automatically load SonicWALL Bare Metal Recovery and Local Archiving - 
Workstation, allowing you to recover the damaged partitions. 

2.4 Removing the program 
To remove SonicWALL Bare Metal Recovery and Local Archiving - Workstation from 
your PC, select Start → Settings → Control Panel → Add or Remove 
Programs →  SonicWALL Bare Metal Recovery and Local Archiving - 
Workstation →  Remove. You will see a dialog to confirm the program removal. 
Click Yes to confirm and SonicWALL Bare Metal Recovery and Local Archiving - 
Workstation will be completely removed. You may have to reboot your computer 
afterwards to complete the task. 
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Chapter 3. General program information 

3.1 Main program window 
The main program window contains the menu, the toolbar, the sidebar, the Active 
Tasks pane and the main area. The main area contains operation icons, while the 
sidebar features Tools and Help panels.  

 

The main program window 

Most of the operations are represented two or even three times in different window 
areas, providing several ways to select them for more convenience. For example, 
you can start the necessary operation or tool by clicking its icon in the main area or 
by selecting the same item from the Operations or Tools menu. 

The main window contains operation icons divided into two groups. 

The Task group contains the following operations: 

Backup – create a backup archive 

Recovery – restore data from a previously created archive 

The Tools group contains the following items: 

Plug Image – connect a disk/partition image as a virtual drive 

Unplug Image – disconnect the connected virtual drive 

Check Archive – runs the archive integrity checking procedure 

Show Log – opens the Log Viewer window. 
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3.1.1 Program menu 

The program menu line features the Operations, View, Tools and Help items. 

The Operations menu contains a list of the available operations, including 
scheduling tasks. 

The View menu contains items for managing the program window look:  

Toolbars – contains commands that control toolbar icons 

Common Task Bar – enables/disables the sidebar 

Status Bar – enables/disables the status bar 

Active tasks – enables/disables the Active Tasks pane at the bottom of the main 
area. 

The Tools menu contains the following items: 

Check Archive – runs the archive integrity checking procedure 

Create Bootable Rescue Media – runs the bootable media creation procedure 

Show Log – opens the Log Viewer window 

Options – opens a window for editing default backup settings and text appearance 
(fonts). 

The Help menu is used to invoke help and obtain information about SonicWALL 
Bare Metal Recovery and Local Archiving - Workstation. 

3.1.2 Active Tasks pane 

The Active Tasks pane displays the scheduled and currently-being-executed tasks. 
It features its own toolbar. You can customize this toolbar view by right-clicking on 
it and selecting the desired options. 

3.1.3 Status bar 

At the bottom of the main window, there is a status bar divided into two parts. The 
left side briefly describes the selected operation; the right side indicates operation 
progress and results. If you double-click on the operation results, you will see the 
logs window. 

3.1.4 Taskbar notification area icon 

During most of the operations, a special indicator icon appears in the Windows 
taskbar notification area (the right portion of the status bar with the clock). If you 
mouse over the icon, you will see a tool tip indicating the operation’s progress. This 
icon doesn’t depend on the main program window being open. It is present for 
background execution of scheduled tasks as well. 
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Chapter 4. Creating backup archives 
To be able to restore the lost data or roll back your system to a predetermined 
state, you should first create a data or entire-system backup file. 

Backing up the entire system disk (creating a disk image) takes more disk space but 
enables you to restore the system in minutes in case of severe data damage or 
hardware failure. Moreover, the imaging procedure is much faster than copying 
files, and may significantly speed the backup process when it comes to backing up 
large volumes of data. 

4.1 Backing up disks and partitions (image backup) 

1. Invoke the Create Backup Wizard by clicking on the backup operation icon in 
the main program window. 

2. Click Next. 

3. Select disks or partitions to back up. You can select a random set of disks and 
partitions.  

 
4. Click Next. 

5. Select the name and location of the archive file.  

If you are going to create a full archive, type the file name in the File Name line, 
or use the file name generator (a button to the right of the line). If you select an 
existing archive, it will be overwritten. 
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The “farther” you store the archive from the original partition, the safer it will be in 
case of data damage. For example, saving the archive to another hard disk will 
protect your data if your primary disk is damaged. Data saved to a network disk or 
removable media will survive even if all your local hard disks are down. 

 

You should have DVD UDF recording software installed for burning images on DVD disks, for 
example: Roxio DirectCD or Ahead InCD.  

6. Click Next. 

7. Select the backup options (that is, backup archive splitting, compression level, 
password protection, pre/post backup commands, checking the backup data 
integrity). You may Use default options or Set the options manually. If the 
latter is the case, the settings will be applied only to the current backup task. 
Alternatively, you can edit the default options from the current screen. Then your 
settings will be saved as default. See 4.2 “Setting backup options” for more 
information. 

8. Click Next. 

9. Provide a comment for the archive. This can help prevent you from restoring the 
wrong disk/partition. However, you can choose not to make any notes. The backup 
file size and creation date are automatically appended to the description, so you do 
not need to enter this information. 

10. Click Next. 

11. At the final step, the backup task summary is displayed. Up to this point, you 
can click Back to make changes in the created task. Clicking Proceed will launch 
the task execution.  

12. The task will appear on the Active tasks pane of the main window. The task 
progress will be shown in the special window. You can stop the procedure by 
clicking Cancel. 

You can also close the progress window by clicking Hide. The backup creation will 
continue, but you will be able to start another operation or close the main program 
window. In the latter case, the program will continue working in the background 
and will automatically close once the backup archive is ready. If you prepare some 
more backup operations, they will be queued after the current.  

 

You may want to adjust the backup process priority. To do so, click on the process icon in 
the System Tray and select Low, Normal, or High priority from the appearing menu. How to 
set the default priority, see in 4.3 “Setting backup options”. 

 

If you burn an archive to several removable media, be sure to number them, since you will 
have to insert them in order during the restoration. 

13. You may want to see the log when the task is completed. To view the log, click 
the Show Operation Logs button on the toolbar. 
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4.2 Setting backup options 

To view or edit the default backup options, select Tools → Options → Backup 
Options from the main program menu. You can edit the default (or set the 
temporary) backup options while creating a backup task as well. 

 

4.2.1 Archive protection 

The default setting – no password. 

An archive can be protected with a password. To protect the archive from being 
restored by anybody except you, enter a password and its confirmation into the text 
fields. A password should consist of at least eight symbols and contain both letters 
(in the upper and lower cases preferably) and numbers to make it more difficult to 
guess.  

If you try to restore data from a password-protected archive, SonicWALL Bare Metal 
Recovery and Local Archiving - Workstation will ask for the password in a special 
window, allowing access only to authorized users. 

4.2.2 Compression level 

The default setting – Normal. 

If you select None, the data will be copied without any compression, which may 
significantly increase the backup file size. However, if you select Maximum 
compression, the archive will take longer to create. 

The optimal data compression level depends on the type of files stored in the 
archive. For example, even maximum compression will not significantly reduce the 
archive size if the archive contains essentially compressed files, like .jpg, .pdf or 
.mp3. 
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Generally, it is recommended that you use the default Normal compression level. 
You might want to select Maximum compression for removable media to reduce 
the number of blank disks required. 

4.2.3 Backup process priority 

The default setting – Normal. 

The priority of any process, running in a system, determines the amount of CPU 
usage and system resources allocated to that process. Decreasing the backup 
priority will free more resources for other CPU tasks. Increasing of backup priority 
may speed up the backup process due to taking resources from the other currently 
running processes. The effect will depend on total CPU usage and other factors. 

4.2.4 Archive splitting 

Sizeable archives can be split into several files that together make the original 
archive. A single archive can also be split for burning to removable media. 

The default setting – Automatic. With this setting, SonicWALL Bare Metal Recovery 
and Local Archiving - Workstation will act as follows.  

When backing up to the hard disk: If the selected disk has enough space and 
its file system allows the estimated file size, the program will create a single archive 
file.  

If the storage disk has enough space, but its file system does not allow the 
estimated file size, SonicWALL Bare Metal Recovery and Local Archiving - 
Workstation will automatically split the image into several files. 

 

FAT16 and FAT32 file systems have a 4 GB file size limit. At the same time, the existing 
hard drives capacity may reach as much as 160GB. Therefore, an archive file might easily 
exceed this limit, if you are going to back up the entire disk. 

If you do not have enough space to store the image on your hard disk, the program 
will warn you and wait for your decision as to how you plan to fix the problem. You 
can try to free some additional space and continue or click Back and select another 
disk. 

When backing up to a diskette, CD-R/RW, DVD-RW or DVD+R/RW: 
SonicWALL Bare Metal Recovery and Local Archiving - Workstation will ask you to 
insert a new disk when the previous one is full. 

Alternatively, you can select Fixed size and enter the desired file size or select it 
from the drop-down list. The archive will then be split into multiple files of the 
specified size. That comes in handy when backing up to a hard disk with a view to 
burning the archive to CD-R/RW, DVD-R/RW or DVD+R/RW later on. 

 

Creating images directly on CD-R/RW, DVD-RW, DVD+R/RW might take considerably more
time then it would on a hard disk. 

4.2.5 Additional settings 

1. Check archive 
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The default setting – disabled. 

You can choose to check the backup data integrity. Verification will be performed 
immediately after the archive is created. 

2. Ask for first media 

The default setting – enabled. 

You can choose whether to display the Insert First Media prompt when backing 
up to removable media. With the default setting, backing up to removable media 
may be impossible if the user is away, because the program will wait for pressing 
OK in the prompt box. Therefore, you should disable the prompt when scheduling a 
backup to removable media. Then, if the removable media is available (for example, 
CD-R/W inserted) the task can run unattended. 
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Chapter 5. Restoring a disk (partition) 
from an image 

As mentioned above (see "Running SonicWALL Bare Metal Recovery and Local 
Archiving - Workstation"), SonicWALL Bare Metal Recovery and Local Archiving - 
Workstation can be run in several ways. However, disk restoration is always 
performed just one way. 

We recommend that you restore disks using Windows, only using other methods if 
Windows doesn’t load. 

The boot disk (e.g. a CD) from which you loaded the program does not keep you 
from using other CDs with images. SonicWALL Bare Metal Recovery and Local 
Archiving - Workstation is loaded entirely into RAM, so you can remove the bootable 
CD to insert an image disk. 

To restore a partition (disk) from an image, SonicWALL Bare Metal Recovery and 
Local Archiving - Workstation must obtain exclusive access to this partition (disk). 
This means no other applications can access it at that time. If you receive a 
message stating that the partition (disk) can not be blocked, close applications that 
use this partition (disk) and start over. If you can not determine which applications 
use the partition (disk), close them all. 

5.1 Selecting an image to restore from 
Find and select a file containing an image of the required partition. The File Name 
field will reflect its name and the Next will become available. 

 

Image selection for restoration 
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If you are to restore an image from removable media, e.g. CD, first insert the last CD and 
then follow instructions of the Restore Image Wizard. 

If you provided a comment to the image, it will help you know if you selected the 
right image to restore. The comment is displayed in the right part of the window. 
Note that the comment can be seen without entering a password for a protected 
image. However, the contents of such an image will still require a password. 

If an image was protected with a password, SonicWALL Bare Metal Recovery and 
Local Archiving - Workstation will ask for it. The Next button will be disabled until 
you enter the correct password. 

5.2 Checking image integrity before restoration 
Before an image is restored, SonicWALL Bare Metal Recovery and Local Archiving - 
Workstation can check its integrity. 

To do this, flag Yes, I want to verify the image archive on the Verify Archive Before 
the Restoring page of the image restoration wizard.  

 

Checking image integrity before restoration 

This is disabled by default in SonicWALL Bare Metal Recovery and Local Archiving - 
Workstation. 

5.3 Selecting a partition to restore 
A single file might contain images of several partitions or even disks, as shown in 
the figure below. 
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Select a partition to restore 
During a single session, you can restore several partitions or disks, one by one, by 
selecting one disk and setting its parameters first and then repeating these actions 
for every partition or disk to be restored. 
Select the necessary partition and click Next. 

5.4 Selecting a location to restore to 
As a rule, you should restore an image to the same partition from which the image 
was created. 
It is possible to restore an image to another partition. A partition should be at least 
the same size as the uncompressed image data.  
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Select partition to restore image to 

 

All the data stored on the restored partition will be replaced by the image data, so be careful 
and watch for non-backed-up data that you might need. 

5.5 Selecting partition type 
When restoring a partition, you can change its type, though it’s not required in most 
cases. 

To explain why you might need to do this, let’s imagine that both OS and data were 
stored on the same primary partition on the damaged disk. You are forced to 
restore the partition from a backup to another hard disk with its own partitions and 
OS. 
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Select partition type 

If you need only the data, you do not have to create another primary partition. In 
this case, you can restore the partition as a logical partition to access the data only. 

But if you are to restore a system partition, you should select the Primary type for 
it. Finally, if you want to load an operating system from it, select Active as well. 

 

Selecting Active for a partition without an installed operating system could prevent your PC 
from booting. 

5.6 Selecting a file system 
Though it is seldom required to change a partition file system, you can change it 
during its restoration. For partitions with FAT native file systems you can choose 
between  FAT16 and FAT32. For partitions with Ext native file systems you can 
choose between  Ext2 and Ext3. For partitions with other native file systems this 
option is not available. 
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Select a file system 

Let’s imagine you are to restore a partition from an old, low-capacity FAT16 disk to 
a newer disk. FAT16 would not be effective and might even be impossible to set on 
the high-capacity hard disk. That's because FAT16 supports files up to  4 GB, so you 
won’t be able to restore a 4 GB FAT16 partition to a disk that exceeds that threshold 
without changing the file system. 

It would make sense here to change the file system from FAT16 to FAT32 by setting 
the appropriate software switch. 

But you must also keep in mind that not all operating systems support FAT32. MS-
DOS, Windows 95 and Windows NT 3.x, 4.x do not support FAT32 and will not be 
operable after you restore a partition and change its file system. These can be 
normally restored on a FAT16 partition only. 

However, you can easily convert a FAT16 partition with newer OS into FAT32. 

 

The operating systems summary is provided in Appendix A. 

5.7 Selecting restored partition size 
In some cases, you might need to change the partition configuration and size during 
restoration. SonicWALL Bare Metal Recovery and Local Archiving - Workstation is 
flexible enough to do this. 

You can resize and relocate a partition by dragging it or its borders with mouse or 
by entering corresponding values into the appropriate fields. 
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Select partition size and location 

 

You might need to resize and relocate a partition in order to redistribute the disk space 
between existing partitions. In this case, you will have to restore the partition to be reduced 
first. 

5.8 Assigning a letter to a partition 
Windows utilizes letters to identify disks and partitions, automatically assigning 
them at loading. 

Under Windows NT/2000/XP, SonicWALL Bare Metal Recovery and Local Archiving - 
Workstation enables you to assign any unused letter to a restored partition (logical 
disk). To do this, select Yes, I want to assign a logical drive letter to restored 
partition. If you don’t set this switch, no letters will be assigned to the restored 
partition, hiding it from OS. Under Windows 9x/Me, this step is bypassed since 
letters are assigned automatically. 
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Assign any unused letter to a partition 

You should not assign letters to partitions inaccessible to Windows, such as to those 
other than FAT and NTFS. 

5.9 Checking file system integrity 
Having restored a disk/partition from an image under Windows NT/2000/XP, 
SonicWALL Bare Metal Recovery and Local Archiving - Workstation can check the 
integrity of its file system. 

To do this, flag Yes, I want to check file system after the restoring on the 
Check File System After the Restoring page of the image restoration wizard. 



Restoring a disk (partition) from an image  

 

24 

 

 

Checking file system integrity after restoration 

This is disabled by default in SonicWALL Bare Metal Recovery and Local Archiving - 
Workstation. 

 
Only FAT16/32 and NTFS file systems integrity can be checked.  

 

5.10 Restoring several partitions at once 
You can restore several partitions during a single session. To do this, select Yes, I 
want to restore another partition or hard disk drive in the Next Selection 
window and click Next. 
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You can restore another partition during this operation 

After this, you will see the partition selection window again and will have to repeat 
the actions mentioned above. 

If you want to restore only one disk (partition) or have already selected all of the 
partitions you need, don’t set this switch and click Next. 

5.11 Restoration script 
In the next window, you will see a disk or partition image restoration script 
containing a list of operations to be performed. 
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Restoration script 

After you click Proceed, SonicWALL Bare Metal Recovery and Local Archiving - 
Workstation will start image restoration, indicating the progress in the special 
window. If you click Cancel, no changes will be made to disk(s). 

You can also stop the procedure by clicking Cancel. However, it is critical to note 
that the partition that should have been restored from the image will be deleted and 
its space unallocated – the same result you will get if the restoration is 
unsuccessful. To recover the “lost” partition, you will have to restore it from the 
image again. 

After the restoration is finished, you will see a message about its results.
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Chapter 6. Browsing and restoring 
individual files 

To browse and restore individual files, SonicWALL Bare Metal Recovery and Local 
Archiving - Workstation can connect images as virtual drives, thus letting you 
access them as though they were a physical drive. This means that: 

• A new disk with its own letter will appear in the drives list 

• Using Windows Explorer and other file managers, you will be able to see image 
files as if they were located on a physical disk or partition 

• You’ll be able to find necessary files or folders in order to copy them from the 
virtual disk to the real one 

The connected virtual drive will be read-only and you won’t be able to change 
anything within it. 

6.1 Connecting a virtual disk 
Use Plug Image to connect an image as a virtual disk and click Next in the first 
wizard window. 

6.1.1 Selecting an image 

In the next window, specify the image you want to open as a virtual disk. 

 

Select image to connect 
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If the selected image file is not protected by a password, you will immediately see 
the image comment along with the list of stored partitions. If the file is protected by 
a password, you will see only the comment.  

6.1.2 Selecting partitions to connect and letter assignment 

You must select a partition to connect as a virtual disk. Note that you can’t connect 
the entire disk. 

 

Select partition to connect 

You can also select a letter to be assigned to the connected disk (from the partition 
letter drop-down list.) 

In the next window, you will see a disk-connection script containing a single 
operation. Click Proceed to connect the image as a virtual disk. 

After the disk is connected, the program will run Windows Explorer showing its 
contents. 

Now you can easily copy any file (or folder) from the virtual disk to the real one 
using Windows Explorer or a similar file manager. 

6.2 Unplugging a virtual disk 
We recommend that you unplug a virtual disk after all necessary files and folders 
are copied. However, the virtual disk will disappear after your PC is turned off. 

To disconnect the virtual disk, select Unplug. 

You can also unplug the disk by clicking Unplug Image in the SonicWALL Bare 
Metal Recovery and Local Archiving - Workstation main window.
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Chapter 7. Other operations 

7.1 Checking images 
To be assured that your images are not damaged, you can check their integrity. To 
do this, select Check Image in the Tools group (expand it if it's not) or click 
Check Image on the toolbar. You will see the first wizard window. Click Next to 
continue. 

7.1.1 Selecting image for checking 

In this window, you will see the complete list of connected storage devices, 
including hard disks and other drives. Using Windows Explorer, locate the image file 
to be checked and select it. 

Its name will appear in the File Name field and the Next button will be enabled. 

 

Select image to check 

Click Proceed to continue. Progress will be indicated in the new window. 

You can cancel checking by clicking Cancel. 

After checking is complete, you will see the results window. 
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7.2 Creating bootable media 
In some cases, SonicWALL Bare Metal Recovery and Local Archiving - Workstation 
can be run only from a special bootable diskette or CD. Such a case might be if your 
PC doesn’t boot up normally.  

You can create bootable media during or after the installation. 

For this, you will need a CD-R/RW blank, five formatted diskettes (or two for the 
safe variant), or any other media your PC can boot from, such as a Zip drive.  

Click Create Rescue Media on the toolbar or in the left part of the main window, 
or select Create Rescue Media from the Tools menu. 

You can also create bootable media without loading SonicWALL Bare Metal 
Recovery and Local Archiving - Workstation itself by selecting Programs → 
SonicWALL → True Image → Bootable Rescue Media Builder from the Start 
menu. 

You will see the bootable media wizard that will ask you to select either complete or 
safe loader version. The latter doesn't have some devices drivers and is useful only 
in case the complete version doesn’t work. 

After you create a boot disk, identify it and keep it in a safe place. 
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Troubleshooting 

7.3 Recovering SonicWALL Bare Metal Recovery and Local Archiving 
- Workstation 

If SonicWALL Bare Metal Recovery and Local Archiving - Workstation ceases running 
or produces errors, its files might be corrupted. To fix it, you will have to recover 
the program. To do this, run the installer again. It will detect SonicWALL Bare Metal 
Recovery and Local Archiving - Workstation on your PC and will ask you if you want 
to recover (update) or remove it. 

Click Recover and click Proceed. 

7.4 Frequently asked questions 
How do I use SonicWALL Bare Metal Recovery and Local Archiving - 
Workstation on a Linux-based PC? 

SonicWALL Bare Metal Recovery and Local Archiving - Workstation supports the 
most popular Linux file systems, including Ext2, Ext3 and ReiserFS. 

SonicWALL Bare Metal Recovery and Local Archiving - Workstation can be run from 
a special bootable diskette or CD independently of operating system installed. 

Having been run this way, it allows you to perform any disk (partition) image 
creation or restoration operations on a Linux-based PC. 

What storage devices does SonicWALL Bare Metal Recovery and Local 
Archiving - Workstation support for keeping backups? 

Backups can be created on hard disks, and other storage devices supported by 
Windows 98/Ме/NT 4/ 2000/XP. 

What is the purpose of specifying image file size? 

The PC hard disk is the fastest and most effective storage device. It can write a disk 
(partition) image considerably faster than any other device, such as a CD-R/RW. 
Having specified image volume size equal to 600–650Mb, you can quickly create 
image files on your hard disk that you can burn to CD-R/RW media afterwards. This 
allows you to do the entire task much more quickly. 

What devices can a system partition be restored from if SonicWALL Bare 
Metal Recovery and Local Archiving - Workstation is loaded from its 
bootable diskette or CD? 

SonicWALL Bare Metal Recovery and Local Archiving - Workstation supports any 
connected hard disks as well as CD-R/RW, DVD+R/RW, DVD-RW and a wide variety 
of FireWire (IEEE-1394) and USB (1.0, 1.1, 2.0) devices. 
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Can Easy CD Creator 4.x–5.0 impede SonicWALL Bare Metal Recovery and Local 
Archiving - Workstation? 

Easy CD Creator 4.x and 5.0 automatically installs an old version of Take Two® 
backup utility that is no longer supported by its manufacturer, Roxio. If SonicWALL 
Bare Metal Recovery and Local Archiving - Workstation detects this utility, it shows 
you the following message in the beginning of image creation: 

"Can’t create the image of the logical disk, as it’s already used by a running 
application. Please close all other applications and try again." 

We recommend that you update your Easy CD Creator to Version 5.1 or newer 
and/or completely remove Take Two®. 

For more information, visit 

 http://www.roxio.com/en/support/roxio_support/taketwo.html  

Is SonicWALL Bare Metal Recovery and Local Archiving - Workstation 
compatible with Roxio GoBack? 

Yes, SonicWALL Bare Metal Recovery and Local Archiving - Workstation is 
compatible with Roxio GoBack under Windows. If you want to load SonicWALL Bare 
Metal Recovery and Local Archiving - Workstation from its bootable media, you will 
have to disable Roxio GoBack first. 

Note that Roxio GoBack will be deleted from your hard disk during the restoration. 

I created an image on CD-R/RW disks, but when I try to browse it, 
SonicWALL Bare Metal Recovery and Local Archiving - Workstation tells 
me it can’t connect this image as a virtual disk. 

The current version of SonicWALL Bare Metal Recovery and Local Archiving - 
Workstation can connect images only if their files are located in the same place. If 
your image is located on several CD-R/RW or hard disks, you will have to copy all its 
files to a single folder on your hard disk. 

I received the "Can’t create image of disk D:, because it’s already used by 
applications or contains bad sectors" error message, where D: stands for 
my logical disk, when I tried to create an image under Windows. 

Your logical disk might contain bad sectors. We recommend that you run a 
complete disk surface test. Under Windows 98/Me, run scandisk and perform the 
complete disk check. Under Windows NT/2000/XP, type “chkdsk /R D:” in the 
command line and reboot. 

How can I burn SonicWALL Bare Metal Recovery and Local Archiving - 
Workstation images to DVD? 

SonicWALL Bare Metal Recovery and Local Archiving - Workstation can burn images 
to DVD under Windows, if you have DVD UDF recording software installed. The DVD 

http://www.roxio.com/en/support/roxio_support/taketwo.html
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must be formatted. Currently, the program supports at least the following DVD 
recording software: 

Roxio DirectCD — optional component of Roxio Easy CD Creator; 

Ahead InCD — available on Nero website freely for Ahead Nero Burning Rom users 
(usually bundled with Nero); 

Veritas DLA and all its OEM versions (e.g. HP DLA); 

Pinnacle InstantCD/DVD 

In general, the program also supports all other DVD UDF burst recording software, 
but the aforementioned applications were tested by SonicWALL for compatibility 
with SonicWALL Bare Metal Recovery and Local Archiving - Workstation. 

To enable image recording to DVD in SonicWALL Bare Metal Recovery and Local 
Archiving - Workstation, you should do the following: 

Install DVD UDF recording software.  

Format DVD disks. DVD+RW and DVD-RW disks can be formatted in any of the 
aforementioned applications, while DVD+R formatting is currently supported by 
Roxio DirectCD only. 

Run SonicWALL Bare Metal Recovery and Local Archiving - Workstation, insert a 
formatted DVD into your DVD+RW or DVD-RW drive and create an image. No other 
special actions are required. 

Images stored on DVD can be restored under Windows and when SonicWALL Bare 
Metal Recovery and Local Archiving - Workstation is loaded from its boot disk.  

There is another way to burn an image to DVD. Using SonicWALL Bare Metal 
Recovery and Local Archiving - Workstation, you can create an image on your hard 
disk and burn it using the installed DVD recording application to a DVD disk 
afterwards. You will be able to restore images from such disks under Windows and 
when SonicWALL Bare Metal Recovery and Local Archiving - Workstation is loaded 
from the bootable media. 

7.5 Technical support 
Users of legally purchased copies of SonicWALL Bare Metal Recovery and Local 
Archiving - Workstation can use free e-mail technical support from SonicWALL. If 
you have installation or working problems that you can’t solve by yourself using this 
manual and the readme.txt file, e-mail the technical support team. 

For more information visit http://www.sonicwall.com/support/contact.html  

 

http://www.sonicwall.com/support/contact.html
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Appendix A Partitions and file systems 

A.1 Hard disk partitions 
The mechanism that allows you to install several operating systems on a single PC 
or to carve up a single physical disk drive into multiple “logical” disk drives is called 
partitioning. 

Partitioning is performed by special applications. In MS-DOS and Windows, these 
are FDISK and Disk Administrator.  

Partitioning programs perform the following: 

• create a primary partition 

• create an extended partition that can be split into several logical disks 

• set an active partition (applied to a single primary partition only) 

 

Information about partitions on a hard disk is stored in a special disk area – in the 1st sector 
of cylinder 0, header 0, which is called the partition table. This sector is called the master boot 
record, or MBR. 

 

A physical hard disk might contain up to 4 partitions. This limit is forced by the partition table 
that is suitable for 4 strings only. However, this does not mean you can have only 4 operating 
systems on your PC! Actually, existing applications called disk managers support far more 
operating systems on disks. For example, SonicWALL OS Selector enables you to install up to 
100 operating systems! 

A.2 File systems 
An operating system gives the user the ability to work with data by supporting some 
type of file system on a partition. 

All file systems are made of structures that are necessary to store and manage 
data. These structures are usually composed of operating system boot sectors, 
folders and files. File systems perform the following basic functions: 

• track occupied and free disk space (and bad sectors, if any) 

• support folders and file names  

• track physical location of files on disks 

Different operating systems use different file systems. Some operating systems are 
able to work with only one file system while others can use several of them. Here 
are some of the most widely used file systems . 
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A.2.1 FAT16 

The FAT16 file system is widely used by DOS (DR-DOS, MS-DOS, PC-DOS, PTS-DOS 
and other), Windows 98/Me, and Windows NT/2000/XP operating systems and is 
supported by most other systems. 

Main features of FAT16 are the file allocation table (FAT) and clusters. FAT is the 
core of the file system. To increase data safety, it is possible to have several copies 
of the FAT (there are usually two of them) on a single disk. A cluster is a minimum 
data storage unit in FAT16 file system. One cluster contains a fixed number of 
sectors. FAT stores information about what clusters are free, what clusters are bad, 
and also defines in which clusters files are stored. 

The FAT16 file system has a 2GB limit that permits a maximum 65,507 clusters that 
are 32Kb in size. (Windows NT/2000/XP support partitions up to 4GB with up to 
64Kb clusters). Usually the smallest cluster size is used to make the total cluster 
amount within the 65,507 range. The larger a partition is, the larger its clusters are. 

 

Usually the larger the cluster size, the more disk space is wasted. A single byte of data could 
use up one cluster, whether the cluster size is 32Kb or 64Kb. 

Like many other file systems, the FAT16 file system has a root folder. Unlike others, 
however, its root folder is stored in a special place and is limited in size (standard 
formatting produces a 512-item root folder). 

Initially, FAT16 had limitations on file names. They could only be eight characters 
long, plus a dot, plus three characters of name extension. However, long-name 
support in Windows 95 and Windows NT bypasses this limitation. The OS/2 
operating system also supports long names, but does so in a different way. 

A.2.2 FAT32 

The FAT32 file system was introduced in Windows 95 OSR2. It is also supported by 
Windows 98/Me/2000/XP. FAT32 is an evolved version of FAT16. Its main 
differences from FAT16 are 28-bit cluster numbers and a more flexible root, whose 
size is unlimited. The reasons FAT32 appeared are the support of large hard disks 
(over 8GB in capacity) and the impossibility to implement any more complex file 
system into MS-DOS, which is still the base for Windows 98/Me. 

The maximum FAT32 disk size is 2 terabytes (1 terabyte, or TB, is equal to 1024 
gigabytes, or GB). 

A.2.3 NTFS 

NTFS is the main file system for Windows NT/2000/XP. Its structure is closed, so no 
other operating system is fully supported. The main structure of NTFS is the MFT 
(master file table). NTFS stores a copy of the critical part of the MFT to reduce the 
possibility of data damage and loss. All other NTFS data structures are special files. 
NTFS stands for NT File System. 
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Like FAT, NTFS uses clusters to store files, but cluster size does not depend on 
partition size. NTFS is a 64-bit file system. It uses unicode to store file names. It is 
also a journaling (failure-protected) file system, and supports compression and 
encryption. 

Files in folders are indexed to speed up file search. 

A.2.4 Linux Ext2 

Ext2 is one of the main file systems for the Linux operating system. Ext2 is a 32-bit 
system. Its maximum size is 16TB. The main data structure that describes a file is 
an i–node. A place to store the table of all i-nodes has to be allocated in advance 
(during formatting). 

A.2.5 Linux Ext3 

Officially introduced with its version 7.2 of the Linux operating system, Ext3 is the 
Red Hat Linux journaling file system. It is forward and backward compatible with 
Linux ext2. It has multiple journaling modes and broad cross-platform compatibility 
in both 32- and 64-bit architectures. 

A.2.6 Linux ReiserFS 

ReiserFS was officially introduced to Linux in 2001. ReiserFS overcomes many Ext2 
disadvantages. It is a 64-bit journaling file system that dynamically allocates space 
for data substructures. 
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